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Introduction

In order to use performance reference compounds (PRCs) in association with polyethylene (PE) passive
samplers, one must be able to use the measurements of PRC losses for individual PE samples to infer the
degree of approach to PE-environment equilibrium in every case. Typically, multiple PRCs of varying
hydrophobicities are used, and their behaviors reflect the dependency of the rates of mass transfer
processes on the chemical properties. With such sample behavior calibration, one can then estimate
the corresponding approaches to equilibration of other contaminants of interest. This very important
result allows the investigator to adjust measured concentrations of targeted contaminants accumulated
in the PE up to the concentrations they would have achieved had the sample been allowed to reach
equilibrium with the surrounding environment.

The following information is designed to enable users of PE passive samples to readily process PRC data
from their PE deployments. Briefly, we describe (a) how the graphical user interface (GUI) uses the
model of Fernandez et al. (2009), (b) how well its performance compares against experimental data, (c)
how the user may prepare their computer with software to use the PRC calculator, and then (d) how to
use the GUI that has been designed for this purpose.

The GUI is based on the passive sampler/sediment mass transfer model of Fernandez et al. (2009). It
uses the measured fractions of PRCs lost (fprc 10st) @fter a sampler has been deployed to calculate a
regression line between the model-estimated K'y and K,,. (NOTE: in the model of Fernandez et al.
(2009), K'4 is the sorption coefficient given on a per volume basis: that is, the sorbed concentration per
volume of water-wet sediment divided by the concentration per volume of water.) This best-fit
equation can then be applied to other compounds besides PRCs to determine their corresponding K'ss,
and the mass transfer model can be applied again to calculate how close to equilibrium (fiqrget,eq) these
compounds were after the time of deployment.
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If the PRC and the target were effectively the same compound (e.g., *C-labeled PCB congener 101 and
its corresponding unlabeled form), then the fraction of PRC loss would be equal to the fraction of target
equilibrated. Thus, if all the PRC were lost after a particular deployment time, then the target compound
would be fully equilibrated; but if only 1/3 of the PRC were lost, then the target concentration would
only reflect 1/3 of its approach to equilibrium.

Tests of the GUI

The diffusion model of Fernandez et al. (2009) uses a Laplace transform to obtain its solution and
consequently requires the use of a numerical inversion algorithm. This means that test calculations
performed with it, or with the PRC calculator presented here, cannot be done by hand.



So we first tested the accuracy of the GUI versus the Matlab routine of Fernandez et al. (2009) by
inputting the observed fractional losses of the three PRCs used by the referenced paper (deuterated
phenanthrene, pyrene and chrysene) and calculating the expected fractional equilibration of various
target PAHs. To eliminate any variability due to differences in input parameters, we used the same
values as Fernandez et al. for the compounds’ Kpew, Dpe, Dy, and Koy, the sampler’s deployment time
and thickness, and the sediment porosity. We found that the fractional equilibrations of various PAH
target compounds calculated using the GUI against those determined in Fernandez et al. (2009) showed
agreement to within <0.5%, with occasional differences of 1-2%. These slight deviations stem from the
fact that the GUI uses K4 values with three significant figures (in log units), whereas Fernandez et al.
(2009) used only two. This correspondence should, of course, not be surprising because both the Matlab
routine of Fernandez et al. (2009) and this GUI contain identical mathematical expressions describing
the release or uptake of chemicals from/into PE. The GUI simply offers a user-friendly interface of
sending the required input parameters to the model of Fernandez et al (2009).

In addition, we compared target compound concentrations, inferred using PRCs and GUI calculations, to
values directly measured when the PE and sediment were equilibrated. In benchtop testing so as to
avoid processes that might disrupt sediment-porewater equilibration (e.g. bioturbation, groundwater
exfiltration), Fernandez et al. inserted PE strips loaded with deuterated phenanthrene, pyrene, and
chrysene as PRCs for either 3 or 10 days (Fernandez et al., 2009). After the PE samplers were removed,
porewater was recovered and analyzed for PAHs. Corrections were made for the effects of organic
colloids. Finally, comparing the directly measured porewater concentrations of various PAHs with the
PRC-corrected PE concentrations, normalized by the respective Kpey values, the results were very
comparable, differing on average by a factor of 2 (Figure 1, left).
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Figure 1. Comparisons between PE-sampler inferred concentrations using PRC corrections and
concentrations found (left) by extracting PAHs in porewater from sediments collected at a site in Boston
Harbor (Fernandez et al. 2009) and (right) by exhaustively mixing PE with lake sediments in the
laboratory until the PCBs in the sediment equilibrated with the PE (Apell, unpublished). All PCB target
compounds were between PRCs in terms of size, while the PAHs included compounds within the PRC
size range as well as ones outside that range.

Further, recent work in our laboratory has shown that the mass transfer model also performs well when
applied to PCBs (Figure 1, right). In short, 25 um thick PE preloaded with seven PRCs (**C labeled PCB



congeners with Kow’s ranging from 10> to 10”*) according to the method of Booij et al. (2002), was
exposed to PCB contaminated sediment collected from Lake Cochituate, MA. After a 1-month exposure
in bench-top jars, the PE was removed and extracted, and the concentrations of PRCs and target
compounds were measured by extracting the PE and analyzing via gas chromatography-mass
spectrometry. In parallel the concentrations of target compounds in the PE at equilibrium with the
sediment were determined using a tumbling setup in which PE was exposed to a continuously mixed
sediment slurry (Rainer et al. 2005). Based on the initial concentration of PRCs, the fraction of PRCs
losses were determined and the expected fractional equilibrations of various target compounds were
calculated using the GUI. The expected concentrations of various PCB congeners at equilibrium were
determined by dividing the amount of each target compound measured in the bench top PE by the
corresponding GUI-calculated fractional equilibration for each congener. The PRC-corrected
concentration was then compared against the measured concentration at equilibrium in the PE tumbled
with sediment (Figure 1, right). We found that they agreed on average to within 15% (N=10), and were
at worse within a factor of 1.5 of each other.

To sum, we find that our GUI accurately calculates the fractional gains of target compounds whose
behaviors are suitably calibrated using appropriate PRCs.

Part 1. Installation of Necessary Software

Information on the Graphical User Interface (GUI)

This graphical user interface was developed in MATLAB. In order for it to run on computers without
MATLAB, it needs a MATLAB library called MATLAB Compiler Runtime (MCR) which is available free of
charge on the Mathworks website. The following describes how one may obtain this MCR software.

Installation instructions for Mac users

1. If you are already a MATLAB user and have MATLAB version/release 2013a installed, then you do not
need to install the MCR and can skip to step 4 below. Note that if for any reason the license for your
MATLAB version/release 2013a is expired/not working/not activated, the MCR associated with it will not
be available, and you will have to install the MCR following the instructions bellow. If you have any other
release of MATLAB installed, you will need to install the MCR and this installation should in no way
affect your ability to run MATLAB in the future.

2. Install the MATLAB Compiler Runtime release 2013a for 64 bit computers by going to the following
link: http://www.mathworks.com/products/Compiler/mcr/ . You will see the window shown below
(Figure 2). Select the “Intel 64-bit” option under R2013a. The MCR file should start downloading. This
may take several minutes depending on your internet connection speed.

3. After the download is finished, double click the installer. Follow the instructions on the screen and
accept all the default options. This installation may take ~10 minutes.

4. Download the graphical user interface file PRC_Correction_Sediment_mac64 from the ESTCP website
and double-click on it to run it. When opening this application for the first time, you may get an error
like this: “PRC_Correction_Sediment_mac64” cannot be opened because it is from an unidentified
developer”. In that case you have to go to System Preferences>Security and Privacy>General and change
“Allow applications downloaded from” to “Anywhere”. After you have done this change, double click the
application file again. The application may take a couple of minutes to load, so avoid double-clicking the
icon again for a few minutes. Once the application loads it should look like Figure 3.
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‘ The MATLAB Compiler Runtime (MCRY) is a standalone set of shared libraries that enables the execution of compiled
MATLAB applications or components on computers that do not have MATLAB installed. When used together, MATLAB,
MATLAB Compiler, and the MCR enable you to create and distribute numerical applications or software components quickly
and securely.

To download and install the MCR:

1. Click the version and platform that corresponds to the application or component you are using.

Note: you can find this information in the readme . txt file that accompanies the application or component.

Release Windows Linux Mac
R2013b 32-bit / 64-bit 64-bit Intel 64-bit
R2013a 32-bit / 64-bit 64-bit Intel 64-bi
R2012b 32-bit / 64-bit 64-bit Intel 64-bit
R2012a 32-bit / 64-bit 32-bit / 64-bit Intel 64-bit

2. Save the MCR installer file on the computer on which you plan to run the application or component.

3. Double click the installer and follow the instructions in the installation wizard.

See the MCR Installer documentation for more information.
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At this point, the user can proceed to the User Instruction Section (Part 2. Use of the Graphic User
Interface (GUI)).

Installation instructions for Windows users

1. If you are already a MATLAB user and have MATLAB version/release 2013a installed, then you do not
need to install the MATLAB Compiler Runtime (MCR) and can skip to step 4. Note that if for any reason
the license for your MATLAB version/release 2013a is expired/not working/not activated, the MCR
associated with it will not be available, and you will have to install it following the instructions bellow. If
you have any other version of MATLAB, you will need to install the MCR and this installation should in no
way affect your ability to run MATLAB in the future.

2. Before you can install the MCR, you need to determine if you have a 32 bit or a 64 bit computer. You
can do this by following the instructions on this website http://support.microsoft.com/kb/827218,
either by reading the text under the Automatic version detection results tab or by following the
instructions under Manually determine which version of windows is installed and considering which
operating system you have (e.g., Win 7, Vista, XP as illustrated in Figure 4). If your computer is not more
than 5 years old, it is most likely a 64 bit.

3. Install the MATLAB Compiler Runtime release 2013a for 32 or 64 bit computers by going to the
following link: http://www.mathworks.com/products/Compiler/mcr/ and by clicking on the appropriate
version for your computer (i.e., either the 32-bit or the 64-bit option) under Windows, version R2013a
(see Figure 5). The MCR file should start downloading. This may take several minutes depending on your
internet connection speed.

4. After the download is finished, double click the installer and accept all the default options. This
installation may take ~10 minutes.
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The MATLAB Compiler Runtime (MCRY) is a standalone set of shared libraries that enables the execution of compiled
MATLAB applications or components on computers that do not have MATLAB installed. When used together, MATLAB,
MATLAB Compiler, and the MCR enable you to create and distribute numerical applications or software components quickly
and securely.

To download and install the MCR:

1. Click the version and platform that corresponds to the application or component you are using.

Note: you can find this information in the readme . txt file that accompanies the application or component.

Release Windows Linux Mac

R2013b 32-bit / 64-bit 64-bit Intel 64-bit
R2013a 32-bit | 64-bit 64-bit Intel 64-bit
R2012b 32-bit / 64-bit 64-bit Intel 64-bit
R2012a 32-bit / 64-bit 32-bit / 64-bit Intel 64-bit

2. Save the MCR installer file on the computer on which you plan to run the application or component.

3. Double click the installer and follow the instructions in the installation wizard.

See the MCR Installer documentation for more information.

Figure 5. Window at
http://www.mathworks.co
m/products/Compiler/mcr/
showing option to choose
and download R2013a for a
Windows machine
operating either a 32-bit of
a 64-bit system. NOTE:
click the left-most position
at the intersection of
Windows and R2013a to
get the 32-bit MCR and the
rightmost position in the
same box to get the 64-bit
MCR.




5. Download the graphical user interface file PRC_Correction_Sediment_win64.exe (or

PRC _Correction_Sediment_win32.exe for 32 bit computer) from the ESTCP website and double-click on it
to run it. Loading this application for the first time may take a couple of minutes, so avoid double-
clicking the icon again for a few minutes. Once the application loads, the desktop should look like Figure
6.
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Part 2. Use of the Graphic User Interface (GUI)

The GUI is split into 4 panels: (upper left) User Inputs, (lower left) View/modify compound properties,
(upper right) Results, and (lower right) Additional options. Use of each of these is described in more
detail below.

Entering inputs in the User Inputs Panel

In the User Inputs panel (upper left), the user must first select a PRC compound by highlighting it in the
list and pressing ENTER. This action can be repeated until all the PRCs in use for a particular PE sampler
have been selected. The selected PRCs will appear in the adjacent table. If the desired PRC is not
available in the list box, the “More options” button will load a more complete list of compounds from
which to select.

The user must then fill in the measured fractions of each PRC lost during deployment in the adjacent
box. Note that these inputs should be between 0 and 1. However, due to analytical imprecision causing
some degree of uncertainty in the fractions lost, it is strongly recommended that only fractions lost
between 0.1 and 0.9 be used as inputs in this calculation. If all of the observed PRC losses are higher
than 0.9, then the user should assume that all the compounds with similar properties as the PRCs are
practically equilibrated with their surroundings; in this case, the PRC loss calculation need not be used.
In contrast, if all the PRC losses are smaller than 0.1, a fitted result can still be obtained but it will be
very uncertain and should be treated accordingly.



The third column in the upper left panel is reserved for identifying any isotopic labeling of the PRC. Such
stable isotope labeling affects the PRC's molecular weight and hence its diffusivity in water. This feature
was added for completeness, although in most cases, the effect due to the isotope extra mass is
minimal. The calculation will still run if the user decides to leave this field blank.

Next the user should move to section #2 and enter the deployment time (days), the PE film thickness
(um), and the sediment water-filled porosity (between 0 and 1).

Then moving to section #3 in the User Input panel (upper left), the user selects the target contaminants
of interest. The list box for selecting the target compounds, accessible using the More Options button,
has similar functionality to the PRC list box. The user can select specific target compounds by
highlighting them and pressing ENTER. This action can be repeated until all the desired compounds have
been selected, which will be visible in the Results panel (upper right).

After completing steps 1 through 3, go to step 4 and start the calculation by pressing the Calculate feq
button (fraction equilibrated).

Results (upper right panel)

The results panel (upper right) will display the corresponding fractions to equilibrium (fiargeteq ) for all the
target compounds selected by the user. All the data in this table can be highlighted and copied to Excel
using keyboard controls for Copy (Control+C) and Paste (Control+V). In addition, on the right side of the
panel, it will display the Ky versus K, fit derived based on the PRC data (red symbols are for the PRCs,
and blue symbols are for the target compounds), as well as the statistics of this fit.

In addition, the two buttons, Save Session and Load Session, allow the user to save a copy of the GUI
along with all the entered inputs and results for possible later use.

View/modify compound properties (lower left panel)

If the user would like to do so, this section of the GUI allows the user to see and modify the database of
compound properties that is used by the mass transfer model. The Load Default button will always load
the original set of properties that came with the GUI. We note here that the mass transfer model
requires partition coefficients such as Kpew to be in volume units i.e. Lw/Lpg, so the user should take into
account the density of PE when changing the values of Kpey.

Additional Options (lower right panel)

This panel is reserved for informative options on the mass transfer model (About the Model) and
practical advice for using the GUI (Graphical User Interface Info). Lastly, a feature that allows for
simultaneous, multi-sample analysis can be accessed using the Multi sample PRC analysis button. The
instructions are provided inside the GUI, with a couple of notes here.

First, it is important to follow the template, and enter the names of the PRCs using the same
abbreviations as used in this GUI (see first column of the Properties Table, accessed by pressing the
button View Properties Table). For example, PCB-001 will not be recognized as PCB 1, and so the routine
will not produce a result if PCB-001 is used. The latter name (PCB 1) should be used instead. The
routine is also able to process different numbers of PRCs for each sample. At least two PRCs are
required per sample for the calculation to run. If some samples in the same spreadsheet do not have
inputs for at least two PRCs, the multi sample analysis will run, but those samples will not be calculated.



Fraction PRC losses outside the 0 to 1 window will not be used in the calculation. It is advised that any
PRC loss that the user deems to have “low confidence” should be deleted from the spreadsheet
(replaced with a blank cell).

Second, the user will also be prompted to enter the name of the output file (no .csv extension is
needed). This file can be accessed once the calculation is finished. The file will have as headers the
sample names, the statistics of the Ky vs Ko, fit on the next 3 lines, followed by the target compounds
and their corresponding fraction to equilibrium. The output file will be a .csv file, just like the input file,
and it can be imported into Excel. On newer versions of Excel, if one just selects File> Open from Excel
and selects the .csv output file (making sure to enable the Show All Files options in the Open dialogue
box), the file will be interpreted directly as a table. If that doesn’t happen, the easiest thing to do is to
go to Data>Get External Data>Import from File and select Comma as a delimiter when prompted.
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